MiniCAD 7 QuicksStart Tutorial — Stage: 1 - Plan Entry

miniCAD7 QuickStart Tutorial

Stage: 1

Enter Survey Plan Information

Aim: To give the user a brief overview of miniCAD7. In Stage 1 you will enter
survey plan information and perform an area calculation.
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Figure 1 - The finished tutorial

Preliminary: There are a few required steps to complete before you can complete
these tutorials. They are:

Download, install and register the software (this may already be completed)

1. Visit the website https://minicad.mapsoft.com.au/Home/Products#download
and download the latest version of miniCAD7 Professional.

2. Run the downloaded file, minicad_setup_V7_X64.exe which can be found in
your Downloads folder. Ignore any messages from Microsoft’s User Account
Control suggesting the software is unsafe!

3. Click on the miniCAD7 icon on your desktop to start miniCAD7. Answer a
few questions.

4. Select Help>>Register from the menu, fill out required information and hit the
Register button.

Download the tutorials

1. Visit the website https://minicad.mapsoft.com.au/Home/Support and download
the Contour and Detail Survey (# 01) found under the Tutorial Resources
section.
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2. Extract the files in the Zip to the folder \documents\minicad\Tutorial 1.

Configure miniCAD

1. Start miniCAD?7. Select Tools>>Options from the menu and select the Open &

Save TAB at the top left.

2. Configure as per the diagram below:
a. 15-minute automatic saves

Create a backup

~®aoo00o

Set the Data file path to \documents\minicad\Tutorial 1
Set the Support file Search to \documents\minicad\Tutorial 1
Set the File Dialogue Memory to Data file path
Check the Edit Job Summary on New File (Preferences TAB)

Program Options  (lan profile )

Open & Save Colours  Points  Units

File Safety
B Automatic save

(] Prompt before saving

Minutes between saves 15
@ Create a backup (meds)

Data File Path
Data File path

C:\Userstian“OneDrive \Documents\minicad'.Supp

Preferences  Tools

From Cumrent Job

Corfig
Config files folder

C:\Usersian“OneDrive\Documents‘\minicad’Supp

Names Profiles
Support File Search
[ Cument job directory
B Support files directory
[T Datafile directary
[ Program directary
Support File path

C:xUsershian \One Drive \Documents minicad Supp

File Dialogue Memory

© Datafile path
() Retain last directory for each dialogue
(") Retain last directory for all dialogues

General

Text scale 1000

(] Student Menus
DXF Import/Open
[ Use cument units

[ Shift4ey: pan

Selection
Ctrlkey to pick add

Shift key to move selection

Cross hair size 10

Pick box size 10

Handle size 7
Update Profile

B8 Code =layer name

Zoom Step 100,00

Update Profile Cancsl Apply Help
Figure 1 — Options — Open and Save
Open & Save Colours Poirts Units  Preferences  Tools  Mames  Profiles

New Jobs
[] Use atemplate file
C:\UsersianDocuments \minicad . Support Templa

@ Edit Job Summary on New File

Diata Entry
Links entry character

Cancel

Apply Help
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Figure 2 — Options — Preferences
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Picture 1 - Survey Plan of site
Start miniCAD and create a new job.

Enter the details in the Job Summary as follows and keep hitting Next>:
1. Job Details (see below)
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Current Job Summary

Step 1 - Job Details

Jjob information.

Job Mame Tutarial 1

RefMNo. 0001

Description Work Experience Tutorial
Client Name Joe Bloggs

Contact Details 0412 345678

Address 53 Minimbah Road

Morthbridge NSW 2063

CAUSERSWANYVONEDRIVENDOCUMENTSWS URVEY JOBSWIC COCHRANE
“Untitled 00.med

Start < Back Mext = Cancel Help

Figure 3 — Job Details

2 Company Details (see below)

Current Job Summary

Step 2 - Company Details

Re our company details.

Surveyed by Little Old Me

Date Surveyed  28th February 2023

Company Work Experience Surveyors

Address 1 Work Experience Way

Wollongong M5W 2555

B Cpen this Summary when Fie New'is selected.

Start < Back Mext = Cancel Help

Figure 4 — Company Details
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3 Plotting (see below — select Scale, Titleblock and North)

Current Job Summary

Step 3 - Plotting

Setup the Plot Page.

PlotScale. 1to 400

Title Block |a-1_Land5capeW'rthGraphic.ttI v|
North Point Symbol [NORTHPOINT v|
Plan Sheet Set Mo, 1 of 1

Lot Details  Area Perimeter

Annotation of Lines | Arcs
© When plotting ) Manual

Start < Back Mext = Cancel Help

Figure 5 — Plot Details

Current Job Summary

Step 4 - Layers from your Field Codes

Set the layenr es, and point symbols from your

Layers Defined Layer Codes

M- —- ELECTRICITY

W FENCE Code Layer Features
: Eﬁ:'TEH AWN STRUCTU..

] PoOOL BLD STRUCTU... Contourable
e HSE STRUCTU..  Contourable
] EHIE | PERG STRUCTU.
TR SHD STRUCTU..  Contourable
B TERRACE

B TREE

B wsll

B wWATER

99 @9

Start < Back Finish Cancel Help

Figure 6 — Layers and Codes
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Layers and Codes — Survey CAD software uses codes the surveyor uses in the field
to identify features such as creeks and buildings and places them in predetermined
layers.

In this tutorial we will add one code that was missed. It is the GAR code, which is
short for GARAGE. It needs to be added to the STRUCTURE layer.

Select the + button at the bottom right of the Layer Codes. Add the GAR code as
shown below and hit the Add New button.
Point Code Detail n

Code GAR e
Layer STRUCTURE

Contourable

Add MNew Cancel

Figure 7 — Code Entry

Have a look at the TR code contained in the TREE layer to see an example of a
symbol. User symbols can be created from within miniCAD?7. This is outside the
scope of this tutorial.

Hit the Finish button. When prompted save the file as Tutorial-1a, select Cancel.

Should you need to view the user defined codes and the layers they are associated with
again, select Tools>>Layers and Codes from the menu.

About coding and the minicad.cod file:

When miniCAD processes field data it parses each entry against a code file called minicad.cod.
This file determines the layer codes are stored in, the layer attributes, such as colour and line-type.
The Symbol name is the same as the code. More information about these coding files is contained
on the Help menu for the Utility Software.

Finally, you are able to start drawing! To do so, Select Draw>>Point.

Enter the information shown in Figure 1 below. Use <TAB> to move between fields
and press the STORE button (the <ENTER> key will also store for you).
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Ne;ﬂ.r Poi;wt o n

Point No. 101]

Easting 1000

Northing 1000

Height

Contourable

Code SSM 5231
i+ ‘ Store Cancel

Figure 8 - Starting point for the job

Select View>>All

The point should appear in the centre of the screen.

Note: It is advisable to use the same point numbering as shown in these tutorial
stages as they will be referred to later.

About Getting Help

Press Shift and the F1 key simultaneously to get help on the dialogue with focus. In an edit
field press the F1 key to display specific help pertaining to that field. Experiment while you
have the New Point Dialogue open. This will work for most dialogue boxes.

More on dialogue boxes:

Most dialogue boxes open at the size and position when they were last used. In addition most
dialogues open with the same data in edit fields. To clear all edit fields press F5. To highlight
an edit field press F2. Pressing F2 again removes highlighting and places the cursor at the end
of the text. (The same as Microsoft Excel !)

« Close the Dialogue. (X in top corner OR press Esc key )

The survey plan information defining the boundaries of Lot 1 and the associated
reference marks are to be entered into miniCAD. Our start point is at SSM 52301 at
the bottom left of Picture 1 above.

Save the Current Job

« Select File>>Save (or Save-As) and name the job Tutorial-1a.

About the Data File Path
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The data file path is where miniCAD expects to find the current job and related files. (Think
of it as a project folder containing many related jobs.) As an example you may have
downloaded the tutorial 1 resources into a new folder on your hard. Make this folder your
current Data File Path.

About the Support File Path
This folder (or folders) is where miniCAD expects to find support files such as the code

library, symbol and line type files and title blocks. Review the help to learn more.

Using Draw Traverse

» Select Draw>>Traverse.

« Snap to point 101 by left clicking near it.

* Enter a bearing of 30°18°15” « Enter a Distance of 36.136 metres.
* Press the Store button.

— Apply Swing

Traverse n Radiation

From Point 101 Use Clock Bearings
Set Next Point No.

Seasing 0.5 Enter Point Attributes

Distance 36.136 Display »
View »
Query »

P —. L
e | Store | Cancel == '

Snaps >

Figure 9 - Traverse Entry and the Right Click Menu.

About Right Click Menus

Right clicking the mouse in the work area (drawing screen) will display a menu with 2 areas:
Upper Area: Functions customised to suit the current tool. (i.e. Apply Swing)
Lower Area: Standard functions ( i.e. such as Display, View, Query, etc..).

These ‘Context Menus’ are available for most tools in miniCAD. Alternatively, you can
choose to only display the Upper Area by left clicking on the Blue Cog to the left of the Store
button. Give it a try!

The next step is to enter a radiation. Right click and select Radiation from the pop-up
menu.

» Enter the radiation to the reference mark of 267°47°30” for 10.5 metres.
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The bearings for all reference marks in the survey plan are shown from the reference
mark to the corner. See the figure below. Note that because we are going from the
corner to the reference mark, a negative distance is entered. Also note that there is no
need to enter trailing zeros in the case of the bearing.

Traverse ﬂ

From Point 102
Radiation 267473
Distance -10.5
i | Store ._ Cancel

Figure 10 — Radiation entry

About Navigation around the screen — Zooming and panning is easy with a wheel mouse.
Simply roll the wheel toward you to zoom out and away from you to zoom in. To pan, hold the
wheel down whilst dragging the mouse.

If you use a laptop or net-book you can configure the shift key to pan and keys F7, F8 and F9
to zoom. (zoom out, zoom in and zoom window respectively). F7 and F8 work relative to the
mouse cursor position.

Right click and select Radiation again (to switch it off) and return to bearings mode.

Enter the following traverse legs:

41°24°30” 7.475

38°58°10” 7.765

311°28°30” 40.31

41°28°30” 0.08

311°00°00”  4.425

4°04°00” 0.55 (Radiation — remember to reverse bearing)

About Display Settings — To see the point numbers use the Display>>Settings menu. It is
available as a right click or from the View menu.

Select Draw>>2 Line Intersection.

Snap to point 102 and enter 311°27°40” in Bearing 1 edit field.
Snap to point 108 and enter 49°46°50” in Bearing 2 edit field.
Press the STORE button to create the intersection point.
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Bearing Intersection (2 Ling) n

Point 1 102

Bearing 1 311.274

Point 2 108

Bearing 2 49 465

& | Store \ Cancel

Figure 11 - Bearing Intersection

» Select Draw>>Line.
» Join points 102 — 110 — 108 with 2 lines.

From 110
To
Last Line: 102-110

() Join 2 Points

& | Store I Cancel

Figure 12 - Line entry

* Right click and select Query>>L.ine.

* Snap to line 108 — 110. Confirm that the distance is 15.449 which is very
close to the 15.45 shown on the survey plan. See figure 7 below.

» Similarly, you can snap to line 110 — 102 to confirm the distance of 47.315.

This command also allows you to click to two points, which is useful if there is
no line joining the two points.

CQuery Line n
From .
To 10

Bearing 2294650

Distance 15.443

Layer PLAN

Q Cancel

Figuf’e 13 - Line query
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About Undo and Redo — If you make a mistake, there are undo and redo buttons which
perform multiple undo and redo’s. To undo, select Edit>>Undo (Ctrl-Z) and redo Edit>>Redo
(Ctrl - Y). What has just been undone or redone is listed in the message area on the status bar.
Try undoing a number of your last commands and then restore your job to normal by redoing
each command again.

Layer upon layer upon layer - to date, we have been drawing in the one layer. We
wish to split the job into 2 layers, PLAN and REFERENCE. The current layer is
displayed in the status bar at the bottom left of the screen. By default’, a new
miniCAD job creates a layer called BASE. Let’s edit our layers:

» Leftclick in the current layer field to open the layer dialogue.

* Right click on the name BASE in the layer name list on the left and select
RENAME. Type PLAN and hit <ENTER>.

» Change the colour of layer PLAN to 3 — Blue.

» Select the NEW LAYER button and enter the layer REFERENCE. Set its
colour to 4 — Red. See figure 8 below.

e Layers — (] 574
- BASE P ] Display / Plotting
W PLAN ([ Coour | (NG
REFERENCE Linetype 0- Solid Point Cross Yes
Line Width 0.25mm . Point No Yes
Plot Yes , Point Height Yes .|
Annotation Yes Point Code |Yes
Visible Yes
Break Line Yes
<«<<less
Statistics:
Current Layer: REFERENCE
Layers used: Points Texts Other LastP
PLAN 7 1} 7 110
REFERENCE 3 0 1 109
Layers empty:
BASE
New Layer Set Cument Ok Cancel

Figure 14 - Layer dialogue

Select OK to close the Layer dialogue box.

About Mouse Selection of Points, Lines and Arcs — When a drawing tool is active (i.e. has
focus) it controls the mouse. Most tools don’t allow the general selection of entities. The
white arrow button on the status bar indicates when general selection is possible.
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Query Line

From

To
Bearing
Distance
Layer

| E: 985,992 N: 1048.292 | 1:564 | [y
Figure 15A — Traverse Tool has focus and has set the cursor. (a cross over a line.)

If you press the arrow on the status bar the current tool will lose focus and you will be able to
make a general selection. See the figure below.

Query Line

From

To

| E: 1021.341 N: 1008.175 RN

Figure 15B — Tool has lost focus. Cursor is a pointer. General Selection is possible.

Changing the Layer of an Existing Entity

» Select point 101 with the mouse. (Click the status bar white arrow first if
needed)

* Hold down the <CTRL> key and select the line 101 — 102.

* Hold down the <CTRL> key and select point 103.

*  Use the wheel mouse to zoom in on point 109. Hold down the <CTRL> key
and select point 1009.
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* Right click and select Layer>>Change Layer to open the Change Layer
dialogue. Make sure REFERENCE is highlighted and press the STORE
button. See Figure 9 below.

Change Entity La}rer_ - E]

Mew Layer

B BASE
B FLAN

Figui’e 16 - Change Layer
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To Calculate the Lot Area.

» Select Query>>Area.
* Click in the middle of the lot.

OR YOU CAN:

» Snap to the lines around the lot, being careful to snap to the correct ends of the
lines. For instance, to travel clockwise around the lot starting from point 102,
snap on line 102 — 110 closest to point 102. Next snap on line 110 — 108
closest to point 110. Continue around the lot in this fashion. You will need to
zoom in on line 106 — 107 as it is very short.

Press F5 to restart the area calculation at any time.
As you move around the lot the distance travelled is also listed in the message area on

the status line. When the start point number is returned to, the area is displayed, in this
case 702.89 square metres. The perimeter of the lot is 122.819 metres.

Area n

From Pt 106)

To Point

Centre Pt

Area 70289

Update Summary Re-Start

Start Pt 106

Last Area 0.00

i | Query | Cancel

Figure 17 - Area calculation

About selecting open and closed strings : Quicker techniques exist to select a closed string
(polygon). Simply click inside the enclosed area. This method may require layers other than
the one containing the polygon to be turned off.

To select a string by segments always start with a point and then each adjacent line or arc. A
collection of points may also be selected, one by one. (i.e. The desired figure must not contain
arcs.)

The creation of strings is discussed in the following tutorials.
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Select File>>Save to complete your job.

Congratulations on reaching the end of this tutorial. By now you can see how easy
miniCAD?7 is to use. You are encouraged to explore the extensive help files associated
with the program and found online. There is also a Support section on the website
listed below, which includes videos and similar tutorials to this one. Should you have
further queries, don’t hesitate to contact us directly.

Mapsoft endeavours to take on board as many user suggestions as possible. Please
don’t hesitate to contact us using the email address below. Enjoy the next tutorial!

Email: info@mapsoft.com.au

Website: www.mapsoft.com.au
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